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CHAPTER
ONE

INTRODUCTION

The Spectroscopic Interactive Pipeline and Graphical Interface (SIPGI) is an evolution of the VIMOS
Interactive Pipeline and Graphical Interface (VIPGI). VIPGI is a complete data reduction environment,
originally designed to carry out the reduction of spectroscopic data acquired with the VIMOS spectro-
graph at the European Southern Observatory (ESO) Very Large Telescope. VIPGI was designed for the
reduction of the VIMOS VLT Deep Survey (VVDS) data, but its capabilities were sufficiently general to
be easily adaptable to a variety of VIMOS data (Scodeggio et al. 2005, Garilli et al. 2012). During the
years, the VIPGI efficiency and the quality of its data reduction products were such to make VIPGI the
reduction pipeline of the major extragalactic surveys carried out with VIMOS: VVDS, zCosmos, VUDS,
VIPERS, VANDELS for a total of more than 200000 spectra fully reduced and calibrated.

1.1 SIPGI: VIPGI and LBT

At the core of VIPGI (and SIPGI as well) is the Data Reduction Software (DRS), i.e. the set of programs
and methods developed for the main steps of the data reduction.

The DRS is designed to be adaptable to other instruments. About ten years ago, SIPGI was born tuning
the VIPGI core to make it able to reduce the spectroscopic data of the two main Large Binocular Telescope
(LBT) spectrographs: MODS and LUCI.

Similarly to VIMOS, MODS is an optical spectrograph, so the main changes concerned the peculiarities
of MODS data but not the deep core of the DRS. LUCI is a near infrared spectrograph and its different
wavelength domain required deep revisions of the DRS. SIPGI has been used by the LBT spectroscopic
data reduction center located at INAF-IASF Milan to reduce all the MODS and LUCI spectra acquired
during the Italian time in the last ten years.

The documentation presented here is a cookbook to reduce MODS and LUCI spectra with this customized
SIPGI version. The documentation is surely not complete, nor exhaustive of all SIPGI functions, features
(and bugs). We rely on users feedback to improve it in the next versions.

For any question, comment, suggestion or for any request of help in the reduction of MODS/LUCI spectra,
please contact lbt-italia-spec @inaf.it



https://www.eso.org/sci/facilities/paranal/decommissioned/vimos.html
https://www.eso.org/public/
https://cesam.lam.fr/vvds/
http://cesam.lam.fr/vvds/index.php
http://cesam.lam.fr/zCosmos/
https://cesam.lam.fr/vuds/
http://vipers.inaf.it:8080/
http://vandels.inaf.it/
http://www.astronomy.ohio-state.edu/MODS/
https://www.mpe.mpg.de/ir/lucifer/
mailto:lbt-italia-spec@inaf.it
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1.2 Overview

SIPGI is composed by two main parts: the built-in data organizer and the DRS.

Although the data reduction recipes in DRS automate to a very large extent the task of reducing spectro-
scopic data, it does not address at all two important and problematic areas of the global data reduction
activity: the organization of the (large) volume of the data and the validation of input data for reduction
recipes. Each reduction recipe works under the assumption that the correct input (in term of calibration
and scientific data) is provided to it, and could produce totally unpredictable results if this assumption
were not to be met. To address these two points SIPGI is provided with a built-in data organizer that
helps to manage the data and to provide the various recipes with the correct input. The organization of
files is not optional in SIPGI. To be processed by the reduction recipes, raw FITS files must be ingested
by the built-in data organizer.

Once files are properly digested and classified, all the recipes of the DRS can be used and their data
products can be inspected using the analysis utilities (see Analysis Utilities).

1.3 How to use this manual

This manual is organized as follow: in Chapter 2 all the information necessary to install the software is
provided, while in Chapter 3 a road-map for the data reduction of MODS and LUCI spectra with SIPGI
is presented. Following the instructions provided in this Chapter, the user should hopefully be able to
fully complete a data reduction. No information on the SIPGI basic concepts and/or on the SIPGI recipes
is provided in Chapter 3. The user can retrieve this information by following the links that are embedded
in the text.

In the following chapters a fully description of the software is provided. In Chapter 4, the SIPGI Auxiliary
system files, i.e. a fundamental part of the SIPGI world, are presented; in Chapter 5, the functioning of
the built-in data organizer is shown; in Chapter 6, a complete description of the graphical interface is
provided; in Chapter 7, all the DRS recipes are described, and finally in Chapter 8, all the Analysis
utilities are explained.

Although the cookbook in Chapter 3 should allow user to complete his/her data reduction, sometimes
the spectra reduction may not be such a straightforward path due to data peculiarities. In this case, a
complete view of what is the software and how it works could help in finding the best solution.

To summarize, we made all our efforts to allow users to reduce their LBT data skipping the boring manual
part related to software functioning, but for a conscious use of SIPGI, it is strongly recommended to read
Chapter 4,5,6,7,8 before Chapter 3 and before starting a data reduction.

Note: In this manual, we try to provide all the support for a quick and easy reduction, however we
assume that the user handles the basic concepts behind the reduction of spectroscopic data.

2 Chapter 1. Introduction



CHAPTER
TWO

HOW TO INSTALL SIPGI

SIPGI is distributed in binary form for Linux and macOS systems as part of the PANDORA SUITE. The
suite can be downloaded from the Pandora website

2.1 Linux

We distribute our code compiled on two Linux flavours. The CentOS 7 distribution is to be used on older
systems (having a GLIBC version >=2.17), while the Xubuntu 18.04 should work on newer ones (having
a GLIBC version >=2.27). Download the installer script for your OS version and execute it:

shell> bash Pandora-1.0-CentOS7.sh
Follow the on-screen instructions and install the suite in a directory of your choice.

Most of the software dependencies are included into the distribution. However a few of them are “system
related” and must be met by the OS on which you are installing our code; in particular our code relies
on the mesa-GLU libraries that are not always installed by default. A check is made at the end of the
installation; in case of error check if the mesa-GLU libraries are installed or contact us at Ibt-italia-
spec @inaf.it.

Once installed SIPGI can be launched using the command <installation-dir>/bin/sipgi.

2.2 macOS

Download the DMG file suitable for you macOS version and open it. Double-click on the Pandora.pkg file
and the suite will be installed into the /Applications/Pandora directory. Depending on the security level
of your system an “unidentified developer” error can appear; in this case right-click on the Pandora.pkg
file and select Open to override this issue.

Once installed SIPGI can be launched in two ways:
* from the command line with the command /Applications/Pandora/bin/Sipgi

* using the macOS app located in /Applications/Pandora



http://pandora.lambrate.inaf.it/
mailto:lbt-italia-spec@inaf.it
mailto:lbt-italia-spec@inaf.it
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CHAPTER
THREE

THE SIPGI REDUCTION COOKBOOK

The reduction procedure within SIPGI consists in the following steps:
* new workspace and a new project creation;
* raw data import into SIPGI;
* bad pixel map creation,;

* master calibration files creation (Master Dark, Master Flat and Master Lamp), both for science
and standard/telluric frames;

* pre-reduction of scientific and standard/telluric frames with a proper Master Flat (and optionally
Master Dark and Master Bias);

* reduction of standard/telluric frames with the proper Master Lamp, if flux calibration is desired;
* sensitivity function creation, if flux calibration is desired;

* reduction of scientific frames with the proper Master Lamp (and sensitivity function if flux cali-
bration is desired);

* combining of all the reduced scientific frames to obtain a combined frame containing the final
spectra for each object in the mask.

Each step is described in detail in the following sections.

3.1 Create a new Workspace and a new Project

Before starting with a new data reduction in SIPGI, the user must group the raw files into a directory (e.g.
/home/user/raw_data, preferentially on internal disk). Ingestion of raw files in SIPGI from external hard
disk takes considerably longer time.

Launch SIPGI and before creating a new Workspace and a new Projects, the user has to set some general
preferences. Click on the SIPGI->Preferences menu in the Starting and Setting Area and set the
primary (see Primary Fits Viewer), and the secondary FITS viewer (see Secondary Fits Viewer) as well
as the log level desired (see the log level note).

Open the workspace creation panel selecting the Workspace->New menu in the Starting and Setting
Area; in the panel insert the Workspace name (e.g. MODS_reduction) and select the Instrument. If
a Workspace for the same instrument already exists, the user can copy the setting parameters from this
Workspace using the Copy setup from entry.

Click on the Create button and the new Workspace is created.
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In the Workspace just created, open the project creation panel selecting Project->New menu in the Starz-
ing and Setting Area. In this new panel define the Project name (e.g. BLZ_reduction) and insert an
existing and empty Project directory (e.g. /home/user/BLZ_reduction), that is the directory where
all the SIPGI imported files (see below) and pipeline reduction products will be stored. This directory
must exist before the creation of a new Project (i.e. SIPGI will not create a directory with the name the
user gives to the Project), and it must not be the raw files directory.

3.2 Files import

To be processed by SIPGI, raw FITS files must be ingested by the built-in data organizer (see Data
organization). During the importing procedure, SIPGI creates a copy of raw files in the Project directory,
and - among other things - rotates and flip the data and appends to them all the necessary auxiliary system
files (for more details see The importing procedure).

Important: During the import procedure, SIPGI creates a copy of raw files. Before starting the inges-
tion, the user must check to have enough space on his/her disk for this copy.

3.2.1 Add mask definition files for MODS MOS data

MODS MOS frames do not contain information about mask geometry. This information is fundamental
to locate the 2D spectra on the frames and it is required by the importing procedure. If data to import
are MODS MOS files, the mask file must be added to the auxiliary files before the data import starts.
Open the Custom Auxiliary Files Manager clicking on the Custom Auxiliary Files button at
the bottom of the 7he Data Manager Area. Click on Add Auxiliary File button. Upload the mask
file in the Auxiliary File panel and fill in all the entries. Please, take care to insert the Mask name.
This field must match the MASKNAME keyword contained in the FITS header of the raw files to import
(see Fig. 3.1).

Note: The Add Auxiliary File button allows the user to add all his/her customized auxiliary files
(e.g. customized stellar template, customized Spectro-photometric standard, customized Lines catalogs,
etc...). Once a new file is uploaded, it is ingested in SIPGI that can use it for reduction purposes. The
Edit File, Rename File and Delete File buttons in the Custom Auxiliary Files Manager window
allows user to edit the specifications of the selected customized auxiliary file, to rename this file or to
delete it from SIPGI. In addition to this, the View/Hide System Files allows the user to see all the
auxiliary system files. The FileType drop-down menu at the top of the Custom Auxiliary Files Manager
window permits to select the type of auxiliary files to show in the central panel.

6 Chapter 3. The SIPGI reduction cookbook
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b Auxiliary File - + X
File: [ID140777)mms | B
Type: | MASK FILE -

Instrument mode: | NoMode =
Quadrant: | NoQuad «
Dichroic: | NoDichroic ~
Arm: | NoArm -

Grism: | NoGrism =

Mask name: |ID140777

Mask number: |-99
Filter name: |Clear =
Channel: | NoChannel «
Readmode: | NoReadmode ~
Savemode: | NoSavemode =
Observing night: | 1/4/21 =

January 04 2021
Exposure time: -99.99

DIT: |-99.99

Created by:

Cancel l oK

Fig.3.1: In figure is reported an example of the Auxiliary File panel for the upload of a mask file. Red
box indicates the Mask name. This entry is mandatory and it must be filled with the same MASKNAME
keyword in FITS header of the raw files.

3.2. Files import 7
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3.2.2 Raw frames import

Note: SIPGI imports only not compressed FITS files.

Clicking on the Import button at the bottom of the SIPGI window, the ImportRawFiles window
appears. The Select directory button allows user to select the directory with raw files (e.g.
/home/user/raw_data) and import all of the FITS files it contains; the Select Files button allows user
to select specific files to import.

Clicking on the Start Import button, SIPGI starts the ingestion of the raw files processing them with
the built-in data organizer (for more details see the The importing procedure).

Caution: The ingestion of raw data can take a while depending on the number of files to import.
Look at the log to follow the import execution. Please, do not stop the import before the process
is finished.

The import procedure creates a number of Datasets and Reduction Units listed in the main panel of the
data manager area.

Raw files import is an incremental procedure; new raw data can be imported as they become available.
For example, if data were acquired in different nights, the user can ingest and reduce the data of the first
nights and then add other files as they arrive. The exposure sequence number provided by SIPGI (see the
renames the file paragraph) to these new imported files follows the sequence of files already ingested.

Note: Data of the same target observed in different periods could have different OBJECT keyword (e.g.
due to a different target name in the Observing Blocks). The import procedure will split these data in
different Datasets. To unify the data in the same Dataset and reduce them together, click on the Datasets
with the right button of the mouse, and rename them with the same name.

SIPGI will not digest and categorize raw files with incorrect entries for the keywords listed in Appendix
B. The files not correctly imported will be stored in the Unclassified panel in the Data Manager Area.

3.3 Bad Pixel Image

The first step in the reduction process is to create the bad pixel image. The Create Bad Pixel Image recipe
is able to automatically detect 2 kinds of bad pixels: dead pixels and hot pixels. Slitless flats are used to
detect dead pixels and dark frames are used to detect hot pixels. If just one type of file is provided, the
bad pixel image will store only the relative bad pixels.

The created bad pixel image will be available in the Master Frame Panel of the current Reduction Unit.

8 Chapter 3. The SIPGI reduction cookbook



SIPGI Documentation, Release 1.1.0

3.3.1 MODS Bad Pixel Image

Select the Reduction Unit with slitless flats. Check the parameter values of the Create Bad Pixels
Image recipe going into Parameter Files->Create Bad Pixel Image menu in the Starting and
Setting Area. To run the recipe, click on the Run button. A new window appears. Select the slitless flats
to be used in the Reduction Unit and then click on the Add files button in the recipe pop-up window.

Caution: Take care to use correct input files, e.g. MODSTI slitless flats for the bad pixel map of
MODST1 data. The drop-down filtering menu on top of Frames Panel of the Reduction Unit can help
in the selection of proper inputs.

Click the Run Recipe button. A new pop-up window will appear with a suggestion for bad pixel im-
age name. A personal name can be provided. It is good practice to give a name that preserves the
filter/dichroic name (e.g G400L, G670L, G400L_Dual, G670L_Dual) and the LBT arm (e.g. MODSI,
MODS?2). This because, e.g., the bad pixel map for MODS1 and MODS?2 will be stored in the same place
(i.e. the Generic Master Frames and Calibration Files of the Project, see Append Bad Pixels Image to
data) and a clear name can help in distinguishing them. The pop-up window allows also to overwrite an
existing bad pixel map with the same name.

Check the result viewing it with one of the two FITS viewer selected and, if it is not satisfactory, modify
the recipe parameters and re-launch the recipe.

The user can save the customized recipe setting parameters using the Save button in the parameters panel.
If the user is satisfied with the parameters stored, he/she can run the recipe directly from the Create Bad
Pixels Image button in the Reduction tab on the left.

3.3.2 LUCI Bad Pixel Image

To create bad pixel image for LUCI data, the procedure is the same as MODS data with the possibility to
also load dark frames to identify hot pixels. Once slitless flat frames have been uploaded in the DEAD
PIXELS FRAMES list panel, dark frames can be uploaded in the HOT PIXELS FRAMES list selecting
them from the appropriate Reduction Unit.

Important: Once the bad pixel map is created, it must be promoted from the Master Frame Panel
of the Reduction Unit in which is created to the Generic Master Frames and Calibration Files of the
Project. This operation will make this data product available to other Reduction Units of the Project. To
do this, click on the bad pixel map with the right mouse button and select Share as auxiliary from
the context menu. This will move the bad pixel map from the Master Frame Panel to the Generic Master
Frames and Calibration Files. If the user wants to delete/rename a file in the Generic Master Frames and
Calibration Files panel, she/he must click on the Custom Auxiliary Files button, must select the file
and perform the desired operation (see this note for more details.).

3.3. Bad Pixel Image 9
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3.3.3 Append Bad Pixels Image to data
Once the user has a satisfactory bad pixels image, he/she must append it to data. This allows the reduction
recipes to have information on the pixels to be corrected for each frame.

Check the parameter values of the Append Bad Pixels Map recipe going into Parameter Files
menu. Select all the data to polish, the bad pixel map itself and click the Append Bad Pixels Image
button in the Reduction Tab.

The bad pixel map must be appended to all the frames that user wants to clean up.

3.4 Create Master Files

The Master calibration frames are: Master Bias, Master Dark, Master Flat and Master Lamp. Together
with the bad pixel maps and sensitivity functions, the master files are those files that are applied to all
the scientific frames.

As for the bad pixel map, after creating the Master frames they appear in the Master Frame Panel of the
Reduction Unit in which are created. In order to use them, the user must promote these file to the Generic
Master Frames and Calibration Files (see the note).

3.4.1 Create Master Bias (MODS only)

Master Bias is used to subtract bias level from MODS science frames.

The creation of a Master Bias is not mandatory in SIPGI. Actually standard practice for MODS data is to
subtract the bias level using the prescan/overscan region. If the user is satisfied with this choice, he/she
can skip the creation of the Master Bias.

If the user wants to subtract bias level using bias frames, he/she must create a Master Bias. Check the
parameter values of the Create Master Bias recipe going into Parameter Files. After this, select
the bias frames and click the Create Master Bias button.

Caution: Frames used to create the Master Bias must have the same ARM and READMODE of
the science frames (e.g. 8kx3k for MODS data, see MODS manual).

A pop-up window appears asking for the Master Bias name and the possibility to overwrite an existing
file with the same name. It is good practice to give a name that preserves the the LBT arm. Run button
launches the recipe.

3.4.2 Create Master Dark (LUCI only)

Master Dark is used to remove the dark current level plus bias level from LUCI science frames.

To create a Master Dark, check the parameter values of the Create Master Dark recipe going into
Parameter Files menu. If the CLEAN_BAD_PIX keyword is activated, append the appropriate bad
pixel map to dark frames (see Append Bad Pixels Image to data).

The user has to select the dark frames and click the Create Master Dark button.

10 Chapter 3. The SIPGI reduction cookbook


http://www.astronomy.ohio-state.edu/MODS/Manuals/MODSManual.pdf

SIPGI Documentation, Release 1.1.0

Caution: Take care to use dark frames with the same ARM, DIT and READMODE of science
frames to reduce.

A pop-up window appears asking for the Master Dark name and the possibility to overwrite an existing
file with the same name. It is good practice to give a name that preserves the READMODE (e.g MER or
LIR) and the LBT arm. Run button launches the recipe.

3.4.3 Pixel to Pixel Variation Image

This image is used to correct for the pixel-to-pixel variation in raw frames. The recipes combines together
input slitless flats and removes from this combined image the large scales fluctuations. The resulting
image only contains the pixel-to-pixel variation (see Create Pix2pix Variation Image for more details).
This step is not mandatory.

The first step to create a Pixel to Pixel Variation Map is to check the parameter values of the Px2Px
Variation Image recipe going into Parameter Files menu. If the CLEAN_BAD_PIX keyword is
activated, append the appropriate bad pixel map to the slitless frames (see Append Bad Pixels Image to
data). After this, select slitless flats and click the button Create Px2Px Variation Image. A pop-up
window appears asking for the Pixel to Pixel Variation Image name and the possibility to overwrite an
existing file with the same name. It is good practice to give a name that preserves LBT arm. Run button
launches the recipe.

3.4.4 Adjust First Guesses

The Reduction recipes in SIPGI rely on a set of models which describe the spectra location on the CCD
(OPT Model), the spectra curvature (CRV Model) and the inverse disperse solution (/DS Model). The
coeflicients of these models are stored in the PAF files. These models provided with SIPGI and appended
to raw files are estimated on the basis of instrument characteristics, but may not be exactly representative
of the current data because of, e.g. changes in the optical distortions on a night base or masks not perfectly
aligned in the FPU. For this reason, they must be checked and if needed, re-adjusted. This interactive
task allows to control the Paf file stored in the input through-slit flat on the input lamp frame.

The first step in this contest is to verify whether calibration files (e.g. through-slit flats and lamps) are
aligned with scientific frames (see the Attention note in the Adjust First Guesses recipe). This can be
easily done opening a flat, a lamp and a scientific frame with ds9 and selecting in it Frame->Frame
Parameters->Tile->Rows.

3.4.4.1 Through-slit flat, lamp and scientific frames alignhed

Select a Reduction Unit with the through-slit flat and click on the flats one desires to use for the Master
Flat creation. Then click the Adjust First Guess button in the Reduction Tab. A new panel opens,
showing on the left the list of flat fields selected. Browse in the Reduction Unit containing the lamp
frames with the same grism/filter/dichroic/arm of the flats and select one of them. Click on the Add
lamp filesinthe Adjust First Guess panel.

The Adjust Grism Table button permits to see and edit the Grism tables. This task allows the user to
check and adjust the Grism Table. As example, in LUCI data with central wavelength different from the
nominal one, the user can update the central wavelength (and extraction limits accordingly). Optionally,
new sky lines can be added to the Grism Table with the the Add Skyline button.

3.4. Create Master Files 11



SIPGI Documentation, Release 1.1.0

Once the Grism Table is set, choose one through-slit flat and one lamp frame in the panel clicking on
them. Then start the adjust procedure selecting the Adjustment type and clicking the Run button. It is
strongly recommended to start with Shift only adjustment type, and then continue with Rotate and
Complete Adjust type.

Note: Standard observations provide user with different lamp frames. Each lamp has their own emission
lines. In order to have a better sampling of the wavelength solution it could be useful to merge lamps
together. To do this, before running the Adjust First Guess task, select all the different lamps, the suitable
Lines catalog from the Generic Master Frames and Calibration Files and then click the Merge Lamps
button in the Reduction tab. A pop up window appears asking for the name of the merged files. Click
Run. The resulting sum file is shown in the lamp Reduction Unit. The user can provide this file as input
to the Adjust First Guess task.

Shift first guesses

This step corrects the OPT model offset adjusting the X and/or Y shifts of the first guesses with respect
to data in use. Select Shift Only as Adjustment type, and push the Run button.

The selected lamp frame is displayed in a new ds9 window, with some green regions superimposed that
show the first guesses of the spectral tracing and of the wavelength calibration following the Paf file stored
in the input flat.

The green vertical lines indicate where the left edge of the spectrum is supposed to be, and the horizontal
lines show where the arc lamp lines (those in the Lines catalog appended to the lamp frame and within
the extraction limits) should be. Clicking on one of the blue rectangles, and moving it, all such regions
will move accordingly.

In this phase the goal is to move green lines (using the blue rectangle) in order to match just the left
edge of the central slit and the position of the most central lines. The center of the green horizontal
lines should be positioned roughly on the center of the corresponding frame lines. It could happen that
edges of other lateral spectra and/or other arc lines are still displaced but this will be fixed in the next
steps. When satisfied, click Recompute on the question panel. The recipe recomputes the OPT Model
using these refined input constraints and will update the green region on the image. The user must check
that the new models have stored the changed suggested. If this is not the case, the user can iterate the
procedure till he/she is satisfied with the newly computed first guesses, and then exit the loop by clicking
on Done.

Attention: Save the first guesses clicking on the Save button on the Adjust First Guess panel. This
will update the Paf file in the selected flat file.
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Rotate

Distortions produce curved spectra, and the CRV Model is the model which describes this curvature. This
step adjusts the first coefficient of the curvature model (the linear term). Choose Rotate as Adjustment
type, and push Run.

The lamp image is displayed in ds9; the green vertical line shows the position of the edge of the spectrum
according to the updated Paf coefficients. Click on the top end or on the bottom end of the green line to
rotate it such that it follows the edge of the spectrum. If necessary, the user can move the vertical line
near the edge of the spectrum to facilitate the tracking.

When satisfied, click Recompute on the question panel. A new CRV Model is computed, and the result
is shown on the same image. It is possible to iterate the procedure, or exit the loop by clicking on Done
when the newly computed first guesses are considered satisfactory.

Attention: Do not forget to push the Save button to store changes into the Paf file in the input flat
file.

Complete adjustment

The complete adjustment is strictly related to the lambda calibration of the spectra and it corrects the /DS
Model. Choose Complete Adjustment as Adjustment type and push Run.

The lamp image is displayed on ds9 again; the green lines show where the arc lamp lines should be
according to the IDS model stored into the flat Paf file.

By clicking on one green line, you can select it and move it so that it falls exactly on the corresponding
arc line. The scope of the game in this phase is to have all the green lines as near as possible to the real
corresponding arc lines. All the shifts in the x directions will be ignored. It is possible to select more than
one region by multiple selection facilities provided by ds9 and move them solidly. A red region with ALL
lines is also shown, to help the identification of very close lines (the user can use it as a ruler and move
such red region around, to help the eye in the most difficult cases). When satisfied, click Recompute on
the question panel. A new set of first guesses is computed, and the result shown on the same image. It
is possible to iterate the procedure, or exit the loop by clicking on Done when the newly computed first
guesses are considered satisfactory.

In this step, the user can activate the entry View lines label which will show for each displayed line
its wavelength.

Important: In the Complete Adjustment:
* the user can delete green lines to exclude them from the fit;
¢ do not mismatch lines;

* push Recompute only when all slits of the whole mask are in the proper position. The recipe
computes a global model and it will fit all the slits; a partially adjusted mask produces a no-sense
fit and all the work will be lost;

* In case some green lines fall out of the frame (too blue or too red) during the adjustment, they can
be deleted and would be excluded from the fit;
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* in LS data, the curvature of emission lines can be so important that the straight green lines can
intercept two close emission lines. This can lead to non accurate wavelength calibration. In this
cases the user can split the line in Split slit part (see Fig. 3.2).

Fig. 3.2: The figure shows the behavior of the Complete Adjustment if Split slit =5.

Once the user is fully satisfied with the first guesses, he/she can save the first guesses pushing on the
Save button.

Note: In the last step it is important to save the new Paf files in all of the through-slit flat of the list. To
do this, the user can choose All frames in the menu Save results into.

3.4.4.2 Lamp frames not aligned with through-slit flat and scientific frames

In case that through-slit flat and science frames are aligned with each other but not with the lamp frames,
the user can use science frames as lamp. In this case the spectral tracing is performed directly on the
science frame bypassing the issue of the shift, and the wavelength calibration is performed on sky lines.

To do this, the user must convert a science frame into a lamp frame using the Science to Lamp button
in the Reduction Tab (see Science to Lamp). Select a raw science frame and a suitable sky-line catalog
from the Generic Master Frames and Calibration Files and click on the Science to Lamp button. This
creates a new file (hereafter science-lamp frame) with the same name of the science frame plus the prefix
Ip. This new frame will appears in the same Reduction Unit of science frames.

Once the science-lamp is created, the user can use this file as lamp in the adjust procedure following the
same steps described in the previous section.
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3.4.4.3 Through-slit flat and lamp frames not aligned with scientific frames

If neither through-slit flats nor lamp frames are aligned with science frames, the user must use science
frames both as flat and as lamp. As in the previous case, the user must use a science frame as lamp
in order to define suitable first guesses for the spectral tracing. However if through-slit flats are shifted
with respect to science frames, it makes no sense to use them as inputs in the Create Master Flat recipe.
To overcome this limit, the user can convert science frames in flat frames using the Science to Flat
button in the Reduction Tab (see Science to Flat). Select a raw science frame and click on the Science
to Flat button. This creates a new file with the same name of the science frame plus the prefix ff
(hereafter science-flat frame). This new frame will appear in the same Reduction Unit of science frames.

Once the science-lamp and the science-flat are created, the user can use these files in the adjust procedure
following the same steps described in previous section. Clearly, in this case, Master Flat will not include
the pixel-to-pixel variation map, unless a Pix2Pix Variation Image is provided (see later).

3.4.5 Master Flat

The creation of a Master Flat is mandatory in SIPGI. It contains two information: the location of 2D
spectra on the CCD and the pixel-to-pixel variation.

The pixel-to-pixel variation is computed by the Create Master Flat using the input through-slit flats or
using the Pix2Pix Variation Image, if provided.

If the user is reducing MODS data, it is strongly recommended to use a dedicated Pix2Pix Variation Image
in order to take into account the different gains between quadrants. This applies also with not-aligned
science and through-slit flat frames.

To create a Master Flat, check the parameter values of the Create Master Flat recipe going into
Parameter Files menu. If the CLEAN_BAD_PIX keyword is activated, append the appropriate bad
pixel map to the through-slit flat frames (see Append Bad Pixels Image to data). Select the through-slit
flat frames (or science-flat frames) to combine, the optional Pix2Pix Variation Image and the optional
Master Bias if MASTER subtracting method has been selected (only for MODS reduction). Click on the
Create Master Flat button. A pop-up window will appear asking for the Master Flat name and the
possibility to overwrite an existing file with the same name. It is good practice to give a name that
preserves the the LBT arm. Run button will launch the recipe.

A Master Flat is created and listed in the Master Frame Panel of the Reduction Unit. The user must
promote it to the Generic Master Frames and Calibration Files.

As stated in Create Master Flat, the Master Flat takes into account for the pixel-to-pixel variation, but
not for large scales variations.

3.4.6 Utilities to check Master files
3.4.6.1 Show Spectra Location

SIPGI offers the possibility to check the Master Flat with the utility Show Spectra Location in the
Analysis Tab. For more details on its functioning see the Show Spectra Location description.

Select one of the through-slit flats used to create the Master Flat and the Master Flat itself. Click on the
Show Spectra Location button. A ds9 window appears showing the through-slit flat with the fitted
tracing highlighted (see Show Spectra Location for more details).
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A Master Flat is considered satisfactory when the tracing follows the spectra edges. This condition is
necessary for a proper extraction of 1D spectra.

Note: Check that the extraction limits (indicated with bold black “lines” in the bluest and reddest part
of the spectrum) are within the tracing limits (white vertical “lines”, see Show Spectra Location for more
details).

The utility Show Spectra Location can be used also on science frames. This allows user to directly
check the spectral tracing on science raw frames.

3.4.6.2 Show Lambda Calibration

Another utility SIPGI provides to check the Master Flat (and Master Lamp) is the Show Lambda
Calibrationinthe Analysis tab (see Show Lambda Calibration for more details). The Show Lambda
Calibration utility allows to check the IDS model stored in the input Master Flat.

Select one of the lamp or science-lamp frame and the Master Flat. Click on the Show Lambda
Calibration button. A ds9 window will appear showing the input frame.

A satisfactory Master Flat has the first guesses of the IDS model (indicated by thin solid horizontal lines)
that provides good prediction of the lamp lines position.

3.4.7 Master Lamp

The creation of a Master Lamp is mandatory in SIPGI. The Master Lamp is the frame which stores in
the EXR table extension the best wavelength solution.

The Create Master Lamp recipe starts from the first guesses of the wavelength solution stored in the EXR
extension of input Masters Flat and refines the models on real data. The best-fitted solution is stored into
the EXR table of the Master Lamp.

The recipe works both on real lamp frames and on science-lamp frames (see Lamp frames not aligned
with through-slit flat and scientific frames).

To create a Master Lamp, check the parameter values of the Create Master Lamp recipe going into
Parameter Files menu. If the CLEAN_BAD_PIX keyword is activated, append the appropriate bad
pixel map to input frames (see Append Bad Pixels Image to data).

Select the desired input frame(s) (lamp frames or science-lamp frames), select the appropriate Master Flat
and the optional Master Bias if MASTER subtracting method has been selected (only for MODS reduction).
Click on the Create Master Lamp button. A pop-up window will appear asking for the Master Lamp
name and the possibility to overwrite an existing file with the same name. It is good practice to give a
name that preserves the the LBT arm. Run button will launch the recipe.

A Master Lamp is created and listed in the Master Frame Panel of the Reduction Unit. The user must
promote it to the Generic Master Frames and Calibration Files.
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3.4.8 Utilities to check the wavelength calibration

Once a Master Lamp is created, the user can visually check the result using the Show Lambda Calibration
utility.

Select one of the lamp or science-lamp frame and the Master Lamp. Click on the Show Lambda
Calibration button. A ds9 window will appear showing the input frame. If no input frame is pro-
vided, the utility displays the solution directly on the master frame image.

In this check the user must control that all the thin horizontal “lines” are placed on the relative emission
lines and that they are fairly continuous. Since the wavelength solutions are computed slice by slice (see
Create Master Lamp for more details), a one-pixel shift between the points of each thin “line” is allowed
due to interization issue. Fluctuations bigger than one pixel indicate a poor calibration in that spectral
region.

Another useful check is to look at the black bold lines which delimit the extraction range. The Create
Master Lamp recipe derives the wavelength solution using all the input lines. This solution is then ex-
trapolated up/down to the red/blue extraction limits. The Show Lambda Calibration utility will show
also the expected position of the extraction limits. If the extraction limits “lines” are blurred, it means that
the best-fit wavelength solution is poorly constrained in the region between the bluest/reddest calibration
line and the relative extraction limit.

3.4.8.1 Check Lambda Calibration

Once the visual inspection is considered satisfactory, the user can quantify the quality of the wavelength
calibration using the utility Check Lambda Calibration in the Analysis tab (see Check Lambda
Calibration description for more details on the utility and its output).

Click the Master Lamp and than click the Check Lambda Calibration button. Look at the log to see
the output. In case the result is not satisfactory, re-perform the Create Master Lamp and/or the Adjust
First Guess steps.

3.4.8.2 Plot Lambda Calibration

Select a Master Lamp and than click the Plot Lambda Calibration button (see the Plot Lambda
Calibration utility for more details). A new panel will appear. It could be necessary to expand the panel
to visualize the plots.

The graphical device has three tabs. In the One slit tab, the top panel shows the offset between the
real wavelength of the line and that associated by the calibration for all the lines in the Lines catalog.
Blue points indicate good points (see Create Master Lamp), red points are those rejected by the fitting
procedure (bad lines, see Create Master Lamp), while magenta triangles are lost lines (see Create Master
Lamp). The latter points are not included in the fit. The View only good points button displays only
the good points in the plot.

The displayed points refers to the S1it and Column indicated in the Browse panel. The default Column
is the central one. The user can change slit and position within the slit using the Previous and Next
buttons or scrolling the cursor on the relative bars. Below the top plot a summary of the quality of the
fit is reported: the number of good lines, the mean value of the offsets and the rms of the distribution,
considering both all of the points and only good points.

The utility offers the opportunity to exclude good points from the fit and repeat the fitting procedure. A
point can be excluded by clicking on it with the right button of the mouse. Its color/shape will change from
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blue point to red diamond. Click the Refit button on the right of the panel. A new fit will be performed,
and the mean and rms values will be updated. The excluded point is shown as black triangle. If the new
fit is considered worse than the original one, the Restore the original fit button restores the plot
and numbers to the original status.

In the One Line tab, the user can focus his/her attention on a specific line using the menu at the bottom
of the panel. Once a line is selected, the deviations measured in all of the columns of the slit for that line
is displayed in the top plot as a function of the slit.

Finally, in the Summary tab, the distribution of the rms for all slits (estimated for the whole slit at the
central position), and a summary table are reported. In this table all the columns can be sorted by clicking
on the top.

3.5 Preliminary Reduction

When the Bad pixel Image, the Master Flat and optionally the Master Dark or Master Bias have been
created “pre-reduction” of the science frames can start. In this first step the user can clean the frames
removing the detector signature and artifacts as bad pixels and cosmic rays. The recipe produces new
frames, with a suffix used to know the operation performed by the preliminary reduction (see Preliminary
Reduction).

To preliminary reduce data, check the parameter values of the Preliminary Reduction recipe going
into Parameter Files menu. If the CLEAN_BAD_PIX keyword is activated, append the appropriate bad
pixel map to science raw frames. Select the raw frames to polish, the Master Flat (optionally the Master
Bias or Master Dark) and then click the Preliminary Reduction button.

Caution: Take care to select the Master Flat with the same filter/dichroic/arm as the raw science.

At the end of the process, the pre-reduced polished files (e.g. BF, or BFC, or DF, or DFC, see Preliminary
Reduction for more details) appear in the Reduction Unit.

3.6 Reduce Observations

This recipe calibrates in wavelength the 2D spectra, optionally subtracts the sky and calibrates in flux,
and extracts the 1D spectra of the detected objects (for more details see Reduce Observations).

It requires in input the pre-reduced frames and a Master Lamp. If flux calibration is desired, a sensitivity
Jfunction must be provided as input. In MODS reduction, if user wants to correct spectra for atmospheric
extinction an extinction table must be provided as input.

To reduce observations, check the parameter values of the Reduce Observations recipe going into
Parameter Files menu.

Select the input pre-reduced frames and the Master Lamp (and optionally the sensitivity function and the
extinction table) and click on the Reduce Observations button in the Reduction tab. A new pop-up
window appears. The usage of this window is related - to some extent - to the reduction strategy adopted,
particularly to the sky subtraction method.

* No sky subtraction or sky subtraction with SKY-METHOD In this case, the order of the input
files is not relevant, as well as the presence or not of dithering. The pop-up window directly
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summarizes the reduction conditions, and the user can click on the Run Recipe button. The
recipe will execute all the steps requested by the user.

* sky subtraction with ABBA-METHOD In the ABBA-METHOD the sky subtraction is per-
formed subtracting from each frame the subsequent dithered one. In this case, the pop-up win-
dow appears with two panels: Science frames and Sky frames. The recipe subtracts from each
frame of the Science frames panel the corresponding frame in the Sky frame panel. The couple
of frames must be dithered. To easily recognize dithered frames, the user can click on the Get
From Header button in the OFFSETS area. The recipe computes the offsets of input files from
their header and updates the Offset column in the Science frames panel. With the help of these
offsets, the user can upload the Sky frames files in the right order and then run the recipe. The user
can modify the order of the input files in both panels dragging and dropping them. Clearly, despite
the name, this method can be used also for observations with dithering pattern more complex then
ABBA (e.g. ABAB, ABCDABCD, etc...).

* sky subtraction with DAVIES-METHOD Similarly to ABBA-METHOD, the DAVIES-
METHOD subtracts from each frame the subsequent dithered one. In this case the pop-up window
shows two panels: Science frames and Sky frames. If the user passes only Science frames, the
recipe subtracts from each frame of the list its subsequent one. From the last frame it subtracts
the previous one. Once files have been uploaded in the Science frames list, and offsets optionally
computed, the user can modify the order of the input files dragging and dropping them. When the
list is ordered, click the Run Recipe button. As alternative, the user can provides also Sky frames.
In this case the recipe acts as in the ABBA METHOD.

In each slits, it is possible to add other files clicking the Add Files button, and remove a file by clicking
on it and then on the Canc button. Finally the user can save the list using the Save List button and can
upload files directly from a list, using the Load List button. This option could be particularly useful
for the ABBA- and DAVIES-METHOD: if the user wants to test different reduction strategies he/she can
upload the list skipping all the organizational steps.

Atthe end of the process, the reduced files replace the pre-reduced ones and an R is added to the name (e.g.
BFR, or BFCR, or DFR, or DFCR). The primary extension of the reduced file is the pre_reduced_frame.fits.
This allows the user to run multiple time the Reduce Observations recipe directly on the reduced
frames, without repeating the Preliminary Reduction since the recipe reads the pre-reduced frame from
their primary extension.

According to the choices made by the user different extensions will be appended to the reduced file. The
2D extracted spectra are stored in the EXR2D extension of the reduced file, while the 1D spectra in the
EXR1D extension. For more details on all the extensions, see the description provided in this section.

The user may desire to compare results obtained with different reduction strategies (e.g. different sky
subtraction methods). To this aim, SIPGI offers the possibility to change the name to a single file or to a
block of files using the context menu (see Context menus). The user can select, e.g. the block of reduced
files, open the context menu and provide the prefix of the file names. SIPGI renames the selected files
using this prefix and enumerates them accordingly to the input frames.
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3.6.1 Utilities to check the reduced observations

Once frames are reduced, the user can look at the results and analyze the output using different utilities.

3.6.1.1 Show Reduced Spectra utility.

SIPGI offers the possibility to check the reduced spectra with the Show Reduced Spectra utility.

Click on a reduced frame and then click the Show Reduced Spectra button in the Analysis Tab. A
SPECTRAL VIEWER window as in Fig. 3.3 will open.
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Fig. 3.3: The Show Reduced Spectra layout

In panel A the EXR2D spectra of a selected slit is shown (the selection can be done in panel E, by default
slit 1 is shown). The two solid lines indicate the extraction regions of the spectra shown in panel B. Panels
C and D show the relative sky and noise spectrum, respectively.

In panel E, the Object tab shows the slit number and the number of the object/detection shown in panel
B (see Show Window Table).

The Browse box allows the user to browse between different slits with the scrolling S1it menu. For a
given slit, the user can visualize the multiple 1D extracted spectra, if available, with the Previous and
Next button in the same box.

The View tab at the bottom of panel E provides the spectrum smoothing tool and the wavelength range
selector tool. The Auto button shows the EXR2D and 1D spectra in their entirety, i.e. it shows the whole
extraction range. The user can change these values according to his/her need. The user can zoom in the
1D (and accordingly in the 2D) spectrum by clicking the left mouse button and dragging it or using the
mouse wheel. The Zoom Out button at the end of the panel restores the original scale.

The Smooth button allows the user to smooth the 1D spectra with a Gaussian kernel with sigma (in
pixel) equal to the provided odd number. The Reset button restores the spectra to their original shape.
To save the smoothed version click the Save button at the bottom of the SPECTRAL VIEWER. This
will overwrite the original 1D spectra.

The 2D Image tab allows the user to set the EXR2D display cut levels (i.e. Low and High) and to mod-
ify the 2D image color-map (and revert it). The Show object limits flag allows to show or not the
extraction limits of the 1D spectra on the EXR2D image (green lines).

Panel E also provides some tools for a quick analysis of the data. The Mouse tab permits to perform the
following operations with the mouse buttons:
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» STATS: this option allows to perform quick statistic for a portion of the spectrum. Select the area
of interest in the 1D spectrum by clicking the right button of the mouse and dragging it. In the
Stats tab at the top of Panel E the selected wavelength range, the median of all of the points in the
selected wavelength range, the standard deviation (std) of these points and a coarse signal-to-noise
ratio (S/N) are displayed. The S/N is computed as the ratio between the median value and the std.

* EDIT: this option allows to edit the spectrum. There are two ways to edit spectrum with mouse:
i) replace a spectrum region with a straight line. Click the right button of the mouse and drag the
mouse to select the editing range: a straight line is drawn from the leftmost selected point up to the
rightmost selected point. i7) replace a punctual spectrum value. Click with the middle button of
the mouse a point in the 1D spectrum panel. The task will connect the selected point to spectrum.
All edits performed to the 1D spectrum can be undone pressing “u” key on the keyboard (up to the
complete restoration of the original spectrum), provided you did not move to a different spectrum.
In case something goes really wrong it is also possible to restore the original data and restart the
editing from scratch clicking on the button “Undo Edits”.

* FIT: this option allows to fit spectral lines. Spectral lines can be fitted using two methods: i)
Gaussian. A Gaussian is fitted in the selected wavelength range (identified clicking and dragging
the mouse) and the results are shown in the Fit tab at the top of panel E. ii) Peak. The peak of the
selected line is computed finding the barycenter of the selected points. The results are shown in
the Fit tab. To clear the fit result from the plot, press “c” key.

In the Redshift box, the user can quickly check the source redshift. Putting the expected redshift, and
flagging the Lines entry, the SPECTRAL VIEWER shows on the 1D spectrum the position of the main
absorption and emission lines according with the provided redshift.

Ext. Profile button shows the extraction profile (see Plot Extraction Profile); Window Table button
shows the WIN table (see Show Window Table). Export buttons export the shown 1D, 2D, noise e sky
spectrum. Clicking the button, a window appear to provide the name and location of the saved files. If
the output file has a FITS extension, the data are saved in FITS file, otherwise in ASCII. Export All
export all the data of the reduced file.

3.6.1.2 Manage D